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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures
CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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As at 30 April 2021

Equity Indices Monthly Performance in

3

April 2021

Sector Indices vs HSI / HSCEI CES120 vs China Theme Indices

Equity Index Futures Access Codes
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Data Source: Bloomberg

Information for reference only



Hang Seng Index (HSI) Futures & Options

Equity Index Futures & Options
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Data Source: HKEX

* OI compared to previous year-end

Information for reference only

HSI Futures (YoY) HSI Options (YoY)

HSI Futures (MoM) HSI Options (MoM)

As at 30 April 2021

HSI Products 

(2021 vs 2020)
ADV OI*

HSI Futures 156,349 (-6%) 110,654 (-15%)

Mini-HSI Futures 115,104 (+3%) 14,327 (-18%)

HSI Options 31,305 (-21%) 168,020 (+3%)

Mini-HSI Options 12,881 (-4%) 11,948 (+38%)

HSI Volatility 

Index Futures
0 (-100%) 0 (-)

HSI Dividend 

Point Index 

Futures

61 (-40%) 4,461 (+16%)
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HSI Futures & Options

Equity Index Futures & Options
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Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 April 2021

Hang Seng Index

 Includes the largest and most 

 liquid stocks listed in Hong Kong

 Index Level  28,724.88 (As at 30 Apr 2021)

 Index Volatility (30-Day Historical)  22.7

 Index Avg. Day High-Low Range  307.13 (Apr 2021)

 HSCEI Correlation (2021)  0.956

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$1.44Mn (As at 30 Apr 2021)

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$10 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Margin as of 01 Apr 2021  HK$97,800

Hang Seng Index Futures

 Index Description

HSI & Top 5 Constituents

Distribution of HSI Index Options OI in Month-end
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Hang Seng China Enterprises Index (HSCEI) Futures & Options

Equity Index Futures & Options
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Data Source: HKEX

* OI compared to previous year-end

Information for reference only

As at 30 April 2021

HSCEI Futures (YoY) HSCEI Options (YoY)

HSCEI Futures (MoM) HSCEI Options (MoM)

HSCEI Products 

(2021 vs 2020)
ADV OI*

HSCEI Futures 127,852 (-12%) 252,037 (-13%)

Mini HSCEI 

Futures
16,881 (-7%) 4,799 (+14%)

HSCEI Options 47,042 (-43%) 1,407,274 (-6%)

Mini HSCEI 

Options
1,659 (-27%) 4,863 (+39%)

HSCEI Dividend 

Point Index 

Futures

1,547 (-14%) 74,711 (+42%)
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HSCEI Futures & Options

Equity Index Futures & Options
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Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 April 2021

HSCEI & Top 5 Constituents
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HSCEI

Comprises the largest and 

most liquid H shares

 Index Level  10,825.25 (As at 30 Apr 2021)

 Index Volatility (30-Day Historical)  23.7

 Index Avg. Day High-Low Range  126.77 (Apr 2021)

 Correlation with HSI, CES120 (2021)  0.956,0.894

 Correlation with CSI300, FTSE A50

 (2021)
 0.688,0.689

 Contract Multiplier HK$50

 Notional Value (1 Contract)  HK$0.54Mn (As at 30 Apr 2021)

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$3.5 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Margin as of 01 Apr 2021  HK$38,400

HSCEI Futures

 Index Description

HSI vs HSCEI 

Distribution of HSCEI Index Options OI in Month-end



Weekly HSI & HSCEI Options Performance
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Data Source: HKEX

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 April 2021

An investment tool to manage short term event risk

Weekly HSI & HSCEI Options Volume
Contract Multiplier  HK$50

Liquidity Providers
 Akuna, Eclipse, I-Access, IMC, Maven, 

Optiver

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$10 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Contract Multiplier  HK$50

Liquidity Providers
 Akuna, Eclipse, I-Access, IMC, Maven, 

Optiver

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$3.5 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Weekly HSI Options

Weekly HSCEI Options
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Single Stock Futures & Options

Equity Futures & Options
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Data Source: HKEX

* OI compared to previous year-end

Information for reference only

As at 30 April 2021

Stock Options (YoY)Stock Futures (YoY)

No. of Single Stock Derivatives

Single Stock Futures 83

Single Stock Options 111

Stock Futures

• Products

 3 A-shares ETFs futures contracts

 Total 83 stock futures contracts

Latest and Future Developments

Stock Options

• Products

 3 A-shares ETFs options contracts

 Total 111 stock options contracts

• Market Makers (MMs)

 3 types of market makers (PMM/ CQMM/ 

QRMM)

 CQMM to provide 50 series continuous 

quotations

Stock Futures (MoM) Stock Options (MoM)
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Single Stock Derivatives ADV (2021 vs 2020) ADV OI*

Stock Futures 12,540 (+173%) 39,447 (+72%)

Stock Options 764,622 (+45%) 10,966,082 (+23%)



Hang Seng TECH Index Futures and Options Performance
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Data Source: HKEX

* Exclude commission fees

Information for reference only

As at 30 April 2021

Volume and Open Interest are Incubating
Providing investors with a tool to manage their risk exposure 

to Hong Kong-listed technology companies

Tracks the largest technology companies

listed in Hong Kong

Hang Seng TECH Index Futures & Options

Contract Multiplier HK$50 per index point

Notional Value (1 Contract) HK$416K (As at 30 April 2021)

No. of Liquidity Providers Futures: 4; Options: 6

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$5.00 / contract

SFC Levy  HK$0.54 / contract

Hang Seng TECH Index

Index Description
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MSCI Asia and Emerging Market Index Futures Performance
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Data Source: HKEX

* Exclude commission fees

Information for reference only

As at 30 April 2021

Volume and Open Interest continue to growth
HKEX with the broadest suite of MSCI derivatives products 

based in the Asian time-zone
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ADV

representation 38 DM and EM countries and

regional indices

MSCI Asia and Emerging Market Index Futures

Contract Multiplier Average US$40

Notional Value (1 Contract) Average US$52K (As at 30 April 2021)

No. of Liquidity Providers 14

Transaction Cost*

Stamp Duty  N/A

Trading Fee  US$0.6-US$1.0 / contract

SFC Levy  US$0.07 / contract

MSCI Asia and Emerging Market Index

Index Description

Open Interest (As of 30 April 2021)

Average Daily Volume (As of April 2021)



MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance
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Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference only

As at 30 April 2021

MSCI AxJ Combines Developed and Emerging Markets (Rebased  to 100)

MSCI AxJ is a well-established benchmark representing Asia 

regional (excluding Japan) equity market performance
Futures contracts have relatively lower transaction costs
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 MSCI AxJ

representation 2 DM countries (excl. Japan)

and 9 EM countries in Asia

 Index Level  670.30 (As at 30 April 2021)

 Index Volatility (30-Day Historical)  21.8

 Index Avg. Day High-Low Range  5.06 (April 2021)

 HSI Correlation (2021)  0.885

 HSCEI Correlation (2021)  0.883

 Contract Multiplier  US$100

 Notional Value (1 Contract)  US$67K (As at 30 April 2021)

 Avg. Quote Size  US$0.34Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  0.9 index points (April 2021)

 Liquidity Providers Flow  and 11 banks

Stamp Duty  N/A

Trading Fee  US$0.5 / contract

SFC Levy  US$0.07 / contract

Margin as of 01 Apr 2021  US$3,210

 Transaction Cost*

 MSCI AxJ Futures

 Index Description
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Hang Seng Mainland Banks Index Futures Performance
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Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 April 2021

Index & Constituents 3-Month Performance (Rebased to 100)

HSMBI Futures can be used for hedgingFutures contracts have relatively lower transaction costs

 Hang Seng Mainland Banks Index (HSMBI)

 10 largest and most representative 

 HKEX-listed mainland banks stocks

 Index Level  3,011.03 (As at 30 April 2021)

 Index Volatility (30-Day Historical)  24.6

 Index Avg. Day High-Low Range  25.25 (April 2021)

 HSI Correlation (2021)  0.638

 HSCEI Correlation (2021)  0.629

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.15Mn (As at 30 April 2021)

 Avg. Quote Size  HK$0.75Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  61.6 index points (April 2021)

 Liquidity Providers  N/A

Stamp Duty  N/A

Trading Fee  HK$2 / contract

SFC Levy  HK$0.54 / contract

Margin as of 01 Apr 2021  HK$8,970

Transaction Cost*

 Hang Seng Mainland Banks Index Futures

 Index Description
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Hang Seng Mainland Oil & Gas Index Futures Performance
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Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 April 2021

Index & Constituents 3-Month Performance (Rebased to 100)

HSMOGI Futures can be used for hedgingFutures contracts have relatively lower transaction costs

 Hang Seng Mainland Oil & Gas Index (HSMOGI)

 7 largest and most representative 

 HKEX-listed mainland oil & gas stocks

 Index Level  1,170.61 (As at 30 April 2021)

 Index Volatility (30-Day Historical)  39.9

 Index Avg. Day High-Low Range  13.22 (April 2021)

 HSI Correlation (2021)  0.536

 HSCEI Correlation (2021)  0.505

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$59K (As at 30 April 2021)

 Avg. Quote Size  HK$0.29Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  30.0 index points (April 2021)

 Liquidity Providers  N/A

Stamp Duty  N/A

Trading Fee  HK$2 / contract

SFC Levy  HK$0.54 / contract

Margin as of 01 Apr 2021  HK$5,760

Transaction Cost*

 Hang Seng Mainland Oil & Gas Index Futures

 Index Description
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Hang Seng Mainland Properties Index Futures Performance
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Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 April 2021

Index & Constituents 3-Month Performance (Rebased to 100)

HSMPI Futures can be used for hedgingFutures contracts have relatively lower transaction costs

 Hang Seng Mainland Properties Index (HSMPI)

 10 largest and most representative 

 HKEX-listed mainland properties stocks

 Index Level  6,586.80 (As at 30 April 2021)

 Index Volatility (30-Day Historical)  32.7

 Index Avg. Day High-Low Range  73.50 (April 2021)

 HSI Correlation (2021)  0.496

 HSCEI Correlation (2021)  0.539

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.33Mn (As at 30 April 2021)

 Avg. Quote Size  HK$1.6Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  94.2 index points (April 2021)

 Liquidity Providers  N/A

Stamp Duty  N/A

Trading Fee  HK$2 / contract

SFC Levy  HK$0.54 / contract

Margin as of 01 Apr 2021  HK$19,870

Transaction Cost*

 Hang Seng Mainland Properties Index Futures

 Index Description

0.16%

0.17%

0.17%

0.17%

0.17%

0.17%

0.24%

0.25%

0.29%

0.37%

1.02%

China Overseas 688.HK

HSMPI Futures

Country Garden 2007.HK

China Vanke 2202.HK

Evergrande 3333.HK

Sino-Ocean Gp 3377.HK

Longfor PPT 960.HK

Shimao Property 813.HK

Kerry Ppt 683.HK

China Res Land 1109.HK

Fullshare 607.HK
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135
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HSMPI Evergrande (3333.HK)
China Overseas (688.HK) Country Garden (2007.HK)
China Res Land (1109.HK)

5-Min Avg. Bid-Ask Spreads (30 April 2021)
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Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 April 2021

0.08%

0.10%

0.15%

1.00%

CSOP FTSE A50 ETF (2822.HK)

X iShares A50 ETF (2823.HK)

ChinaAMC CSI300 ETF (3188.HK)

CES120 Futures

CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)

Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

5-Min Avg. Bid-Ask Spreads (30 April 2021)

80
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130

Feb-2021 Mar-2021 Apr-2021

CES120 Index Tencent CCB

Ping An China Mobile

 CES120 Index

 80 A-Shares and 40 HK-listed Mainland

 China H-shares, P-chips, and red chips

 Index Level  8,389.34 (As at 30 April 2021)

 Index Volatility (30-Day Historical)  21.0

 Index Avg. Day High-Low Range  98.10 (April 2021)

 CSI300 Correlation (2021)  0.908

 FTSE A50 Correlation (2021)  0.917

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.42Mn (As at 30 April 2021)

 Average Quote Size  HK$2.10Mn (5 Contracts)

 Average Bid-Ask Trading Spread  85.1 index points (April 2021)

 Liquidity Providers  N/A

Stamp Duty  N/A

Trading Fee  HK$5 / contract

SFC Levy  HK$0.54 / contract

Margin as of 01 Apr 2021  HK$24,960

Transaction Cost*

 CES120 Index Futures

 Index Description
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Data Source: HKEX

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTI/<yy><m>.HF HTI/<yy><mm>/<strike><t>.HF

Bloomberg L.P. HCTA Index HSTECH Index OMON

Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DZH HTI

East Money 

Information

HTI

ESunny Information HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv 0#HHTI 0#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK



MSCI Asia and Emerging Market Index Futures Access Codes
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Data Source: HKEX

Information 

Vendor

MSCI Australia 

NTR (USD) 

Index Futures

MSCI China 

Free (USD) 

Index Futures

MSCI China 

Free NTR 

(USD) Index 

Futures

MSCI EM Asia 

ex China NTR 

(USD) Index 

Futures

MSCI EM Asia 

ex Korea NTR 

(USD) Index 

Futures

MSCI EM Asia 

NTR (USD) 

Index Futures

MSCI EM 

EMEA NTR 

(USD) Index 

Futures

MSCI EM ex 

China NTR 

(USD) Index 

Futures

MSCI EM ex 

Korea NTR 

(USD) Index 

Futures

MSCI EM 

LatAm NTR 

(USD) Index 

Futures

Bloomberg HKCA Index HMSA Index HJEA Index HQOA Index HQRA Index HRSA Index HQTA Index HQDA Index HQIA Index HQYA Index

Refinitiv 0#HMAN: 0#HMCU: 0#HMCN: 0#HMAC: 0#HMAK: 0#HEAN: 0#HMEE: 0#HMXC: 0#HMXK: 0#HMEL:

WIND MANF.HK MCNF.HK EANF.HK

Information 

Vendor

MSCI 

Emerging 

Markets (USD) 

Index Futures

MSCI 

Emerging 

Markets NTR 

(USD) Index 

Futures

MSCI Hong 

Kong NTR 

(USD) Index 

Futures

MSCI India 

(USD) Index 

Futures

MSCI India 

NTR (USD) 

Index Futures

MSCI 

Indonesia 

Index (USD) 

Futures

MSCI 

Indonesia NTR 

(USD) Index 

Futures

MSCI Japan 

(JPY) Index 

Futures

MSCI Japan 

NTR (JPY) 

Index Futures

MSCI Japan 

NTR (USD) 

Index Futures

Bloomberg HMPA Index HMOA Index HLCA Index HRTA Index HJDA Index HMLA Index HKBA Index HQAA Index HQBA Index HJCA Index

Refinitiv 0#HMEM: 0#HEMN: 0#HMHN: 0#HMDA: 0#HMIN: 0#HMID: 0#HMDN: 0#HMJP: 0#HMJJ: 0#HMJU:

WIND MINF.HK MDNF.HK MJUF.HK

Information 

Vendor

MSCI Malaysia 

(USD) Index 

Futures

MSCI Malaysia 

NTR (USD) 

Index Futures

MSCI New 

Zealand NTR 

(USD) Index 

Futures

MSCI Pacific 

ex Japan NTR 

(USD) Index 

Futures

MSCI Pacific 

NTR (USD) 

Index Futures

MSCI 

Philippines 

(USD) Index 

Futures

MSCI 

Philippines 

NTR (USD) 

Index Futures

MSCI 

Singapore 

Free (SGD) 

Index Futures

MSCI 

Singapore 

Free NTR 

(USD) Index 

Futures

MSCI 

Singapore 

NTR (USD) 

Index Futures

Bloomberg HMYA Index HKEA Index HOPA Index HRPA Index HRBA Index HNSA Index HLEA Index HKOA Index HOBA Index HKPA Index

Refinitiv 0#HMMY: 0#HMMN: 0#HMNZ: 0#HMPJ: 0#HMPC: 0#HMPH: 0#HMPN: 0#HMSG: 0#HMGN: 0#HMSN:

WIND MMNF.HK

Information 

Vendor

MSCI Taiwan 

(USD) Index 

Futures

MSCI Taiwan 

25/50 (USD) 

Index Futures

MSCI Taiwan 

25/50 NTR 

(USD) Index 

Futures

MSCI Taiwan 

NTR (USD) 

Index Futures

MSCI Thailand 

(USD) Index 

Futures

MSCI Thailand 

NTR (USD) 

Index Futures

MSCI Vietnam 

(USD) Index 

Futures

MSCI Vietnam 

NTR (USD) 

Index Futures

Bloomberg HJAA Index HRCA Index HRDA Index HJBA Index HMTA Index HKDA Index HNTA Index HKSA Index

Refinitiv 0#HMTW: 0#HTWP: 0#HTWN: 0#HMWN: 0#HMTH: 0#HMTN: 0#HMVT: 0#HMVN:

WIND MTWF.HK MWNF.HK MTNF.HK



Weekly HSI and HSCEI Options Access Codes
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Data Source: HKEX

MSCI AxJ and MSCI AxJ Futures Access Codes

Information Vendor Weekly HSI Options Weekly HSCEI Options

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name

Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <0#HSIW*.HF> <0#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

Hong Kong and International Information Vendors

Information Vendor MSCI AxJ Index MSCI AxJ Index Futures

AASTOCKS - 221495

Activ Financial - MXJ/<yy><m>.HF

Bloomberg M1ASJ Index MJSA Index CT

CQG - MXJ

DB Power - MXJ

East Money Information - MXJ

Factset - MXJE

ICE Data Services - F:MXJ

Infocast - MXJ

N2N-AFE - 870823

QPWeb - P11203

SIX Financial Information - MXJmy

Refinitiv .MIAX00000NUS 0#HMXJ:

Telequote Data - MXJ/<yy><m>.HF

Tele-Trend - MXJFC, MXJmyy

Hong Kong and International Information Vendors



Sector Index and Sector Index Futures Access Codes
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Data Source: HKEX

Information Vendor Mainland Banks 

Index

Mainland Banks 

Index Futures

Mainland 

Properties 

Index

Mainland 

Properties Index 

Futures

Mainland Oil 

& Gas Index

Mainland Oil & 

Gas Index 

Futures

AASTOCKS 221420 221425 221415

Activ Financial =0200700.HK MBI/16K.HF =0200800.HK MPI/16K.HF =0201000.HK MOI/16K.HF

AFE 837451 870809 837451 870810 837451 870808

Bloomberg HSMBI Index BMWA Index MSMPI Index PPTA Index HSMOGI Index OGIA Index

DB Power MBI MPI MOI

ET Net MBN MBI MPR MPI MOG MOI

Infocast HSMBI MBI MSMPI MPI MOGI MOI

QuotePower SEHK.HHSMBI P11223 SEHK.HHSMPI P11224
SEHK.HHSMO

GI
P11222

Telequote MBImy MPImy MOImy

Refinitiv .HSMBI 0#HMBI: .HSMPI 0#HMPI: .HSMOGI 0#HMOI:

Hong Kong and International Information Vendors

Mainland Information Vendors

Information Vendor Mainland Banks 

Index

Mainland Banks 

Index Futures

Mainland 

Properties Index

Mainland 

Properties Index 

Futures

Mainland Oil 

& Gas Index

Mainland Oil & 

Gas Index 

Futures

East Money HSMBI MBI HSMPI MPI HSMOGI MOI

Hexin Flush Financial MBIC MPIC MOIC

Pobo Financial
MBI+Month+Ye

ar
MPI+Month+Year

MOI+Month+Ye

ar

Qianlong 999905 209 999902 209 999903 209

Wind HSMBI
MBIF+yymm+H

K
HSMPI MPIF+yymm+HK HSMOGI

MOIF+yymm+H

K



CES120 Index and CES120 Index Futures Access Codes
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Data Source: HKEX

Information Vendor CES 120 Index CES 120 Index Futures

Bloomberg Finance L.P. CES120 CESA Index DES <GO>

Refinitiv .HKCES120 0#HCHH:

AAStocks.com Limited 110056 221360

AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH

Infocast Limited CE120 CHH

Interactive Data Group I:CES120 Fn:CHH\MYYDD

Marketprizm Hong Kong Limited CES120 CHHmy

SIX Financial Information Ltd. CES120 CHHmy

Telequote Data International Limited CES120 CHHmy

Hong Kong and International Information Vendors

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code

Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK

Zheng Zhou Esunny Information Technology Co, 

Ltd.
- CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209


